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his section describes how to make 
PDF documents using the two Acrobat 
document creation tools—PDF Writer 

and Acrobat Distiller. It also discusses when 
to use PDF Writer and when to use Acrobat 
Distiller, and provides tips on reproducing fonts 
and minimizing the file size of documents.

 

WHEN TO USE PDF WRITER AND 
WHEN TO USE ACROBAT DISTILLER

 

You can convert most documents into Portable 
Document Format (PDF) using the PDF Writer 
driver included with Acrobat Exchange. There 
are documents, however, for which you must 
use Acrobat Distiller, or for which Acrobat 
Distiller produces better results.

Use Acrobat Distiller to create PDF files when

 

O

 

Your document contains placed Encapsulated 
PostScript (EPS) artwork or images.

 

O

 

You are using an application that generates its 
own PostScript language files when printing or 
that produces the highest-quality output on a 
PostScript printer.

 

O

 

Your document contains high-resolution 
images that you want to 

 

downsample

 

 (reduce 
in image resolution and file size).

 

O

 

PDF Writer produces unsatisfactory results, 
such as poor quality or a large file size. This 
is often the case if your document contains 
complex blends, gradient fills, or EPS artwork 
or images.

 

O

 

You are using an application in a computing 
environment, such as UNIX

 



 

 or DOS, that does 
not include PDF Writer but that allows you to 
create PostScript language files.

 

O

 

You need to convert existing PostScript 
language files into PDF files.

 

HOW TO USE PDF WRITER 

 

To use PDF Writer, select PDF Writer as your 
printer driver and “print” the document to a file 
instead of to a printer.

 

To use PDF Writer from Windows:

 

1

 

Start your application and open the document.

 

2

 

Choose Print from the application’s File 
menu. The Print dialog box appears. 

 

3

 

If the current printer is not Acrobat PDF 
Writer on DISK, click the Print Setup button. 
The Print Setup dialog box appears. Select 
Acrobat PDF Writer on DISK from the Specific 
Printer list, and close the dialog box. 

(In some applications, you can also choose Print 
Setup from the File menu to select the Acrobat 
PDF Writer on DISK, and then repeat step 2.)

 

4

 

In the Print dialog box, click OK. The Save 
PDF File As dialog box appears.

 

5

 

Name the PDF file, and select a destination 
directory.

 

6

 

If desired, choose one of two options:

 

O

 

To view the PDF file in the Acrobat Exchange 
window, select the View PDF File option. 

 

O

 

To enter information about the file, select the 
Prompt for Document Info option. Click OK. 
In the General Information dialog box, enter 
the document’s title (do not enter the PDF file’s 
name unless it is the same as the title), subject, 
author, and keywords in this dialog box. This 
information will be saved with the document.
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Click OK. 

The PDF file is generated and appears on-screen 
in the Acrobat Exchange window if you selected 
the View PDF File option; otherwise, you are 
returned to your application. 

 

To use PDF Writer on the Macintosh:

 

1

 

Start your application and open the 
document.

 

2

 

Hold down the shortcut key (the Control key 
by default) and choose Print from the applica-
tion’s File menu. The PDF Writer dialog box 
appears. 

 

Note:

 

 If the PDF Writer dialog box does not 
appear, select Chooser from the Apple menu, and 
select Acrobat PDF Writer. The PDF Writer 
shortcut key may not work with all Macintosh 
applications.

 

3

 

Select the Select Short (DOS) File Names to 
truncate the default filename in the Save dialog 
box to a DOS filename consisting of eight char-
acters followed by a period and a two- or three-
character file extension (such as 

 

.ps

 

 or 

 

.pdf

 

). 

 

Note

 

: If you plan to distribute the PDF file over 
a network or via an electronic mail system, 
Adobe recommends that you use the MS-DOS 
file-naming convention.

 

4

 

If desired, choose one of two options: 

 

O

 

To view the PDF file in the Acrobat Exchange 
window, select the View PDF File option. 

 

O

 

To enter information about the file, select the 
Prompt for Document Info option. Click OK. 
In the General Information dialog box, enter 
the document’s title (do not enter the PDF file’s 
name unless it is the same as the title), subject, 
author, and keywords in this dialog box. This 
information is saved with the document. 

 

5

 

Click OK. The Save As dialog box appears 
with the name of the PDF file. 

 

6

 

Rename the file, if desired. Select a destination 
folder, and click Save. 

The PDF file is generated and appears on-screen 
in the Acrobat Exchange window if you selected 
the View PDF File option; otherwise, you are 
returned to your application. 

 

To change the PDF Writer shortcut key 
(for the Macintosh only):

 

1

 

Choose Control Panels from the Apple menu, 
and open the PDF Writer Shortcut control panel.

 

2

 

Select the key or key combination you want to 
use. To turn off the PDF Writer shortcut option, 
click Disabled.

 

3

 

Click OK.

 

Selecting PDF Writer compression and font 
options

 

You can specify options to control how the 
PDF Writer formats and compresses files, and 
whether certain Type 1 font outlines are included 
(“embedded”) in PDF files.

 

To select PDF Writer compression and font 
options from Windows:

 

1

 

Choose Print from the File menu, and click 
Setup in the Print dialog box.
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2

 

Select PDF Writer on DISK from the specific 
Printer list, and click Options. The PDF Writer 
on DISK dialog box appears.

 

3

 

Click Compression to change the PDF Writer 
compression options. Select the desired com-
pression options, and click OK.

See the 

 

Acrobat Exchange Online Guide

 

 for 
complete information on compression options.

 

4

 

Click Fonts to display the Font Embedding 
dialog box. Select the desired options, and 
click OK. 

See “Embedding and Substituting Fonts” on 
page 36 for information on embedding fonts.

 

To select PDF Writer options from the 
Macintosh:

 

1

 

Hold down the PDF Writer shortcut key and 
choose Page Setup from your application’s File 
menu, or select Chooser from the Apple menu 
and select Acrobat PDF Writer. 

 

2

 

Click Compression to change the PDF Writer 
Compression options. The PDF Writer Com-
pression dialog box appears. Select the desired 
options, and click OK.

See the 

 

Acrobat Exchange Online Guide

 

 for 
complete information on compression options.

 

3

 

Click Fonts to display the Font Embedding 
dialog box. Select the desired options, and 
click OK. 

See “Embedding and Substituting Fonts” on 
page 36 for information on embedding fonts.
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HOW TO USE ACROBAT DISTILLER

 

To create error-free PDF files, Acrobat Distiller 
needs valid PostScript language files and access 
to the fonts used in the document.

 

Distilling PostScript language files

 

Acrobat Distiller can be used as a personal appli-
cation and as a network application. 

If you are using Acrobat Distiller over a network, 
you create PDF files by dragging or saving Post-
Script language files into a “watched” In directory 
set up by your Distiller administrator. When 
the file has finished distilling, it appears in the 
Distiller’s watched Out directory. 

If you are using Distiller as a personal applica-
tion, you can create PDF files from PostScript 
language files using any of the following 
methods:

 

O

 

Start Acrobat Distiller and open the Post-
Script file you want to distill.

 

O

 

Drag one or more PostScript files onto the 
Acrobat Distiller icon.

 

O

 

Drag or save one or more PostScript files into 
a watched In directory on your hard disk.

To name the PDF file, Acrobat Distiller replaces 
the 

 

.ps

 

 extension with 

 

.pdf

 

. For example, the PDF 
filename created for a PostScript language file 
named 

 

Q1Report.ps

 

 is 

 

Q1Report.pdf

 

.

See “Using Acrobat Distiller over a Network” 
on page 35 for more information.

 

Creating PostScript language files 

 

You create a PostScript language file from your 
document by selecting a PostScript printer 
driver and printing the document to a file. The 
following instructions are for users of the Adobe 
PSPrinter driver. 

Before creating a PostScript language file from 
your document, make sure that the document 
prints correctly on a PostScript printer. Docu-
ments that do not print correctly cannot be 
properly distilled.

 

Tip:

 

 To create a PostScript file and a PDF file in 
one step, save your PostScript file directly to the 
Acrobat Distiller In folder.

 

To create a PostScript language file from a 
Windows document:

 

1

 

Start your application and open the document.

 

2

 

If your default printer is not a PostScript 
printer, choose a PostScript printer from the 
Specific Printer menu. Click OK.

 

3

 

Choose Print from the File menu. The Print 
dialog box appears.

 

4

 

Select the Print to File option and click OK. 
The print to File dialog box appears.

 

Note

 

: If your application Print dialog box does not 
include a Print to File option, you must set up a 
PostScript printer driver to print to a file. See the 

 

Acrobat Distiller Online Guide

 

 for instructions.

 

5

 

Enter a path and filename for the PostScript 
language file, and click OK. By convention, Post-
Script language filenames are named using a .PS 
extension (for example, Q1REPORT.PS).

 

To create a PostScript language file from a 
Macintosh document:

 

1

 

Start your application and open the document.

 

2

 

If you do not normally use a PostScript 
printer driver, select Chooser from the Apple 
menu, select the LaserWriter or PSPrinter driver, 
and click OK.
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3

 

Choose Print from the File menu. The Print 
dialog box appears.

 

4

 

Select File as the destination.

 

5

 

If the document is a color document or con-
tains grayscale images, click Options to display 
the Print Options dialog box, select Color/Gray-
scale from the Print menu, and click OK.

 

6

 

Click Save in the Print dialog box. The Save As 
dialog box appears.

 

7

 

Unless you are sure that Acrobat Distiller has 
access to all the fonts you use in your document, 
select All But Standard 13 from the Font Inclu-
sion menu.

 

8

 

Select the destination folder and enter a name 
for the PostScript language file. By convention, 
PostScript filenames are named using a 

 

.ps

 

 
extension (for example, 

 

Q1Report.ps

 

).

 

9

 

Click Save to create the PostScript language 
file and return to your application.

 

Giving Acrobat Distiller access to fonts

 

When Acrobat Distiller distills a PDF file, the 
program must have access to the fonts used in 
the file. You can give Distiller access to fonts used 
in a document in one of two ways:

 

O

 

By including the font in the PostScript file. 
(For more information, see the previous section, 
“Creating PostScript Language Files.”)

 

O

 

By specifying font folders in the Distiller Font 
Locations dialog box.

 

To specify font folders in the Font Locations 
dialog box:

 

1

 

Start Acrobat Distiller and choose Font Loca-
tions from the Acrobat Distiller menu. The Font 
Locations dialog box appears.

 

2

 

From Windows, click Add Directory; from the 
Macintosh, click Add Folder. The Add Directory/ 
Folder dialog box appears.

 

3

 

Select a directory/folder. Click OK.

 

4

 

When you have finished adding directo-
ries/folders, click Save.

 

Selecting Acrobat Distiller job options

 

Distiller job options include options for com-
pressing files, compressing and downsampling 
files, embedding fonts in files, and generating 
thumbnails.

 

To select job options:

 

Choose Job Options from the Acrobat Distiller 
menu. The Job Options dialog box appears.
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The following sections describe the Distiller job 
options. For more information, see the 

 

Acrobat 
Distiller Online Guide

 

.

 

General options

 

O

 

Compress (LZW) Text and Graphics 
compresses text and graphics with the LZW 
compression method. Text and graphics include 
everything in a document but bitmaps. No 
detail is lost with the LZW compression method.

 

O

 

Generate Thumbnails creates thumbnails of 
document pages. Thumbnails are miniature 
images of pages. You can also create thumbnails 
using the Acrobat Exchange program.

 

O

 

ASCII Format saves PDF files in ASCII rather 
than 8-bit binary format. Because files in binary 
format are typically 20 percent smaller than files 
in ASCII format, binary format is the default. 
This is the recommended format; for more 
information, see “Do Not Use the ASCII Format 
Option” on page 38.

 

O

 

Make Font Subsets embeds only those charac-
ters of the font that are used in a document 
(the font subset). Because this option reduces 
file size and applies to any font that you embed, 
it is recommended that you always embed font 
subsets. See “Embedding and Substituting Fonts” 
on page 36 for more information.

 

Color and grayscale image options 

 

O

 

To produce a smaller bitmap, downsampling 
combines information represented by several 
pixels in a bitmap into a single larger pixel. 
Downsampling reduces the size of images with 
some loss of detail. 

Images are downsampled in whole number 
divisions of their original resolutions. You con-
trol downsampling by specifying a minimum 

resolution for downsampled images. Given 
the minimum resolution, each image is down-
sampled as much as possible. For example, given 
a minimum resolution of 72 dpi, a 200-dpi 
image is downsampled to 100 dpi, and a 150-dpi 
image is downsampled to 75 dpi. See the 

 

Acrobat 
Distiller Online Guide

 

 for complete information.

 

O

 

Compression options enable you to compress 
color or grayscale images with either the LZW 
or JPEG compression method. No detail is lost 
with the LZW compression method. With JPEG 
compression, the less detailed parts of an image 
are compressed more than the more detailed 
parts of an image. At the Low and Medium-Low 
settings, the loss of detail is usually unnotice-
able. See the 

 

Acrobat Distiller Online Guide

 

 for 
complete information.

 

Monochrome images compression

 

You can compress monochrome images using 
one of the following compression methods:

 

O

 

CCITT Group 3–Compression of images one 
line at a time

 

O

 

CCITT Group 4–Good general-purpose 
compression method for monochrome images

 

O

 

LZW–Best for images with repeating patterns

 

O

 

Run Length–Best for images with large areas 
of solid black and white

 

TIPS FOR USING ACROBAT DISTILLER

 

This section contains tips for using Acrobat 
Distiller. See the 

 

Acrobat Distiller Online Guide 

 

for complete instructions and tips on using the 
program. To open the online guide, start Acrobat 
Distiller and choose Acrobat Distiller Help from 
the Help menu (Windows) or from the Balloon 
Help menu (Macintosh).
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Using Acrobat Distiller over a network

 

Acrobat Distiller can be installed on a PC or 
Macintosh to service any number of users 
with access to the network. In this case, the 
Distiller administrator sets up a location, called 
a “watched” directory, for the Distiller In and 
Out directories. Users connect to this location 
and use the folders to distill and retrieve files. 

Using Acrobat Distiller over a network has the 
following advantages:

 

O

 

The ability to continue working on your 
computer while Acrobat Distiller creates PDF 
documents 

 

O

 

The ability to support hundreds of users

 

O

 

The ability to support users with system 
memory limitations (because Acrobat Distiller 
runs on another system)

 

Setting up multiple watched directories

 

Acrobat Distiller can be set up to watch up to 
100 directories. You can set up several In and 
Out directories with different job options to 
accommodate different types of files. For exam-
ple, one directory’s job options can be set to 
generate thumbnails (for online use), another 
to compress color images using the highest 
JPEG compression (for low-resolution output), 
and another to turn off downsampling (for 
high-resolution output).

 

Using Distiller Assistant for Windows

 

The Acrobat Distiller Assistant for Windows 
program enables you to “print” a file directly to 
the Acrobat Distiller printer, and thus produce a 
PDF file in one step. Distiller Assistant also 

 

O

 

Monitors the Acrobat Distiller watched direc-
tories and starts Acrobat Distiller if a file appears 
in any In directory. 

 

O

 

Accepts files that are dragged onto its 
program icon and, if necessary, starts Acrobat 
Distiller and directs it to distill the files.

The Acrobat Distiller Assistant is installed in 
the Acrobat Distiller directory (normally 
c:\acrodist) as distasst.exe. The installer adds 
an “Acrobat Distiller on \distasst.ps” item to 
your list of installed printers. Select this printer 
to “print” to a PDF file. A Distiller Assistant item 
is also added to the Adobe Acrobat 2.0 program 
group. 

For more information on the Distiller Assistant, 
see the 

 

Adobe Acrobat Distiller Online Guide

 

.

 

Important:

 

 The Distiller Assistant program must 
be running to perform any of its tasks. To ensure 
that the Distiller Assistant is always running, 
copy the Distiller Assistant program item to the 
Windows Startup group. The Distiller Assistant 
program will then start each time you start 
Windows. 

 

Creating PostScript files from QuarkXPress 
and PageMaker

 

The 

 

Acrobat Distiller PPD

 

 (Printer Page Descrip-
tion) file included with Acrobat Distiller enables 
QuarkXPress and PageMaker users to create 
colored and custom-sized PostScript files. Such 
files cannot be created using a standard printer 
driver. 

The 

 

Acrobat Distiller PPD

 

 file is installed in the 
correct location for your system when you 
install the Acrobat Distiller program. (It can also 
be found in the Acrobat Distiller Xtras folder.) 
The PPD may be distributed to anyone creating 
QuarkXPress or PageMaker files that will be 
distilled on your computer.
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Important:

 

 If you use QuarkXPress or PageMaker 
with Acrobat, be sure to read the instructions for 
using these programs contained in the 

 

Adobe 
Acrobat Distiller Online Guide.

Distilling multiple PostScript files

The RunFile procedure enables you to combine 
multiple PostScript files into a single PDF file. 
You can also use this procedure to

O Include PostScript headers from directories 
other than the Startup directory/folder 

O Distill PostScript files located in directories 
other than those Acrobat Distiller monitors

O Distill an entire directory of PostScript files

See the Acrobat Distiller Online Guide for step-by-
step instructions on using the RunFile procedure.

EMBEDDING AND SUBSTITUTING FONTS

Acrobat Exchange and Reader programs 
reproduce each font in a document in one of 
three ways:

O By using the same font installed on the 
viewing computer

O By creating a substitute font using informa-
tion in the PDF file

O By displaying a font that has been embedded in 
the PDF file

When a font has been embedded, Exchange and 
Reader can display and print the font on any 
computer without relying on font substitution. 
Both the PDF Writer and Acrobat Distiller auto-
matically embed non-ISO Type 1 fonts—that is, 
fonts with nonstandard character sets. Embed-
ding these fonts ensures that they will be dis-
played properly even when they are unavailable 
on the current computer. 

You may want to set up both programs to embed 
additional Type 1 fonts and avoid font substitu-
tion for any of these reasons:

O You are using decorative fonts, such as Adobe 
Wild Type fonts, or script fonts, such as Park 
Avenue . Substitute fonts for these types of fonts 
do not look like the originals.

O Users will print the document on early model 
PostScript printers with little memory. Font 
substitution may require more printer memory 
for each font that is substituted.

O You want to ensure that a font will display like 
the original on Macintosh, Windows, UNIX, 
and DOS systems. 

Note: A font embedded using PDF Writer typically 
requires between 25K and 40K of storage; a font 
embedded using Acrobat Distiller with the Make 
Font Subsets option (the default option) typically 
requires 10K to 25K of storage. 

To find out whether a font has been embedded 
in a file, use the Document Info/Fonts com-
mand in the File menu.

To embed all fonts:

1 Display the Font Embedding dialog box, as 
described in the Windows or Macintosh proce-
dure in “Selecting PDF Writer Compression and 
Font Options” on page 30. 

2 In the Font Embedding dialog box, select 
Embed All Fonts.

3 Click OK.

To embed specific fonts:

1 Display the Font Embedding dialog box, as 
described in the Windows or Macintosh proce-
dure in “Selecting PDF Writer Compression and 
Font Options” on page 30. 
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2 In the Font Embedding dialog box, deselect 
the Embed All Fonts check box. Select the 
Always Embed check box.

3 From the Available Fonts list, select the names 
of fonts that you want to embed in all PDF doc-
uments. Click Add to embed the selected fonts 
in the PDF document.

4 Click OK when you have finished adding 
fonts.

To embed all fonts except specific fonts:

1 Display the Font Embedding dialog box, as 
described in the Windows or Macintosh proce-
dure in “Selecting PDF Writer Compression and 
Font Options” on page 30. 

2 In the Font Embedding dialog box, select the 
Embed All Fonts check box. Select the Never 
Embed check box.

3 From the Available Fonts list, select the names 
of fonts that you do not want to embed in all 
PDF documents. Click Add to exclude these 
fonts from the PDF documents. 

4 Click OK.

Note: You may embed Adobe Originals and fonts 
owned by Linotype-Hell AG, International Type-
face Corporation, Agfa-Gevaert, Fundición 
Typográfica Neufville, and Monotype Typography, 
Ltd. that are available from the Adobe Type 
Library. You may need permission from the font 
supplier to distribute PDF files containing other 
embedded fonts. 

Embedding TrueType and multiple 
master fonts

Like Type 1 fonts, TrueType fonts can be embed-
ded in PDF documents. If a PDF file of a docu-
ment containing TrueType fonts is created using 

PDF Writer, Acrobat Exchange and Reader use 
the original TrueType font when the document 
is displayed on the same platform (Windows, 
Macintosh, UNIX, or DOS). If a PDF file of a 
document containing TrueType fonts is created 
using the PDF Distiller, the fonts are converted 
to PostScript fonts. 

Although Acrobat Distiller does not embed 
TrueType or multiple master fonts directly, 
you can use both of these types of fonts in your 
document without any problem. If a TrueType 
font is selected in the Distiller’s Font Embedding 
dialog box (or Embed All Fonts is selected), 
a PostScript version of the TrueType font is 
embedded. For most purposes, this version of 
the TrueType font is acceptable; however, if you 
need to embed the actual TrueType font, you 
must use PDF Writer.

In addition, Acrobat Distiller embeds an 
instance of any multiple master font used in a 
document. This instance is a valid Type 1 font, 
and is thus compatible with all Acrobat 1.0 and 
2.0 viewers. 

TIPS FOR MINIMIZING PDF FILE SIZE

This section offers suggestions and guidelines 
for keeping the size of PDF files to a minimum.

Use the Save As command to save changes

After changing a PDF file with the Acrobat 
Exchange program, save the changes with the 
Save As command (not Save). The Save com-
mand saves incremental changes by, for exam-
ple, marking deleted pages as invalid but not 
removing them. The Save As command rebuilds 
files by removing all deleted objects.
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Do not use the ASCII Format option

By default, both the Acrobat Distiller and PDF 
Writer programs create 8-bit binary files. This is 
the recommended setting because many elec-
tronic-mail, file-transfer, and network programs 
add characters and otherwise corrupt ASCII-
formatted PDF files. An Acrobat viewer may not 
be able to read such corrupted files. 

However, in some cases, you may have to select 
the ASCII Format option because some older 
versions of file transfer programs cannot suc-
cessfully copy 8-bit binary files. (Almost all 
recent versions of file transfer, electronic-mail 
programs, and network copy operations can 
successfully transfer 8-bit binary files.)

Compress text and graphics

Both the Distiller and PDF Writer programs 
have options for compressing text and graphics 
to reduce the file size when they create a PDF 
file. In addition, the Distiller also lets you down-
sample (reduce the resolution) of bitmapped 
images when you compress them. See the next 
section, “Downsample Files for Low-resolution 
and Online Use,” for more information.

Text and graphics include any figure, illustra-
tion, or graphic that is not a bitmapped image. 
Bitmapped images include images created by 
paint and photo-retouching programs, scanned 
images, and screen shots created by screen 
capture programs. Bitmapped images require 
much more storage space than text and simple 
drawings—and high-resolution images, such as 
24-bit color images obtained from a scanner, 
require even more. A 2-inch by 3-inch 24-bit 
color image, for example, requires many mega-
bytes of storage space.

Keep in mind the following when selecting com-
pression options:

O The Distiller lets you specify separate 
compression options for color and grayscale 
images, but the PDF Writer does not. See the 
“Compressing Color and Grayscale Images” 
topic in the Acrobat Distiller Online Guide for 
more information.

O The LZW method compresses images without 
reducing image quality; these compressed 
images view and print exactly as uncompressed 
images. 

O The JPEG compression method reduces 
image quality, but can compress images far more 
than the LZW method. 

O Using JPEG to compress screen shots distorts 
the images. However, if you save screen shots as 
either 8-bit (color) or 4-bit (grayscale) images, 
the files are compressed using the LZW method, 
even if you have selected the JPEG method. To 
avoid distorting screen shots, you can also distill 
pages that contain screen shots separately and 
substitute these pages in the PDF file.

O Monochrome image compression does not 
reduce image quality. You should always 
compress monochrome images if file size is an 
issue. See the “Tips for Compressing Mono-
chrome Images” topic in the Acrobat Distiller 
Online Guide for advice on choosing a compres-
sion method.

Downsample files for low-resolution and 
online use

Most users view PDF documents with 96-dpi or 
lower resolution monitors, and print the docu-
ments with 400-dpi or lower resolution printers. 
To minimize PDF file size, consider downsam-
pling bitmapped images to match the resolution 
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of the laser printer used to reproduce them. If 
the document is mainly for online use, consider 
downsampling the images to match the highest 
resolution monitor your readers will use.

See the “Tips for Downsampling Bitmapped 
Images” topic in the Acrobat Distiller Online 
Guide for more information.

Convert color images

To reduce PDF file size and speed display, con-
vert CMYK images to RGB. RGB images require 
less storage, display faster, and their colors often 
look better on-screen. 

Tip: You can use the Example.ps file in the Acrobat 
Distiller Startup directory to convert CMYK files 
to RGB as they are distilled. For more information 
on using this file, see “The Startup Folder/Direc-
tory” in the Acrobat Distiller Online Guide.

You may also want to try converting color EPS 
images to TIFF. For some applications, color 
TIFF images require less storage space than color 
EPS images. (Grayscale TIFF and EPS images are 
about the same size.)

Adobe Photoshop can convert EPS images to 
TIFF. HiJaak  by Inset Systems can also convert 
many graphic formats, including EPS, to TIFF.

Minimize embedded fonts

If maintaining very small files is important, 
avoid embedding fonts in the PDF file. See 
“Embedding and Substituting Fonts” on page 36 
for information on embedding fonts.
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